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1 Install / Uninstall Synkronizer

1.1 Versions

There are five different versions of Synkronizer available. These versions contain the following:

Light
Version

Standard
Version

Premium
Version

Developer
Version

Shareware
Version

Highlight differences ü ü ü ü ü

Create a difference re-

port

ü ü ü ü

Navigator ü ü ü

Access-, ODBC-Files ü ü

Synkronizer VBA ü ü

Price EUR 29.-- EUR 49.-- EUR 69.-- EUR 149.-- Free! *

* the shareware version expires 30 days after installation.

Please note that the user manual refers to the developer version only.

1.2 Installation Instructions

Just follow these easy steps to install Synkronizer:

1. Start the file syxl80.exe and follow the install instructions.

2. Open Excel. The menu entry "Synkronizer XL 8.0" appears in the menu "Tools". Now 

the installation has been completed successfully.

Problems with French Excel versions:

If you are working with a French version of Microsoft Excel the following error message may 

occur:

This workbook has been password protected with an encryption scheme not 

available in this region. This workbook cannot be opened.

This is an known error by Microsoft and is described in the following articles:

http://support.microsoft.com/default.aspx?scid=kb;EN-US;q278679

http://support.microsoft.com/default.aspx?scid=KB;EN-US;213833

If you are working with Excel 97, you can solve the problem by taking the following steps:

- change the country settings from French to English

- open Synkronizer

Versions of Synkronizer

Installation

French Excel-Version
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- reset the country settings

If you are working with Excel 2000 you can solve the problem with the following Microsoft 

hotfix:

http://www.synkronizer.com/download/RC4Encr.zip

- download the winzip file

- extract and install the hotfix

By taking these steps you will easily solve the password protection problem.

1.3 Install Synkronizer manually

You can also install Synkronizer manually by taking the following steps:

1. The install program of Synkronizer copies the Synkronizer files to the directory 

C:\Programs\Synkronizer XL 8.0.

2. Copy the file syxl80.xla and the Synkronizer language files (filetype "slf") to a directory of 

your preference

3. Open Excel and select the menu Tools → Add-Ins (if it is not possible to select the menu 

Add-Ins, open a new Excel worksheet. Now it is possible to select the menu)

4. Click on Browse and locate and choose the file syxl80.xla, then click on OK.

5. The menu entry "Synkronizer XL 8.0" appears in the menu "Tools". Now the installation 

has been completed successfully.

1.4 Uninstall Synkronizer

Synkronizer is uninstalled with the following instruction: Start → Programs → Synkronizer 
XL 8.0 → Uninstall Synkronizer XL 8.0

1.5 Uninstall Synkronizer Manually

You can also remove Synkronizer manually by taking the following steps:

1. Select the menu Tools → Add-Ins (if it is not possible to select the menu Add-Ins, open a 

new Excel worksheet. Now it is possible to select the menu)

2. Remove Synkronizer from the add-ins available list.

3. Delete all files in the Synkronizer folder. Synkronizer is installed in the following folder:

C:\Program Files\Synkronizer XL 8.0
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2 Synkronizer Main Menu

Synkronizer is started with the menu instruction Tools → Synkronizer XL 8.0. An input mask

appears, which is divided into three registers. The functions and properties of the Synkronizer 

main form are explained in the following chapters.

2.1 Register "Main Menu"

In the register "Main Menu" you can determine the files and worksheets which are to be com-

pared.

The input mask is divided into three areas which are described as follows:

2.1.1 1st file (Master) / 2nd  file (Update)

Here you choose the files to be compared. The "first file" is the "Master" file and contains the 

older data, the "second file" the newer data or "Update". With the "Open File" buttons you can 

browse your file system to find the required Excel files.

With the dropdown "Worksheet(s)" you can decide which worksheets are to be compared.

You can either compare two worksheets or all worksheets of both files together. In this case 

select "(all worksheets)". Synkronizer then compares all worksheets with identical worksheet 
names.

Start Synkronizer

Select files

compare all worksheets
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File Types

If you are working with Excel XP (Version 10.0) and the "Developer Version" of Synk-

ronizer, the following file types are also supported:

File type: File extension:
Access databases *.mdb, *.mde

External databases *.odc, *.udl, *.dsn

Text files *.txt, *.csv, *.prn, *.tab

Webpages *.htm, *.html,  *.mht, *.mhtm

XML files *.xml (Excel XP)

Note:
If you wish to compare an Access or other ODBC databases, the data will be imported as snap-

shot. Please note that Synkronizer only compares Excel copies of the databases. This 

means that a maximum of 65,535 data records may be compared and that the databases can-

not be updated. The option  for updating the external databases will be included in a future ver-

sion of Synkronizer.

2.1.2 Worksheet options

Here you can determine the worksheet properties:

"normal" worksheets

are ordinary worksheets which do not contain column headings and primary keys (IDs). 

Please note that the data should not be sorted.

Databases

are Excel worksheets, that contain a database structure. The data must be arranged as follows:

• The first row contains unique column names.

• The database contains one column with primary keys (unique identification number, article 

number etc.). A primary key identifies the data records and facilitates the sorting and syn-

chronizing of your data. The primary key does not need to be a single column, it can also be 

formed from two or three columns (e.g. family name, first name and city). Disadvantage of 

multiple column primary keys: duplicate indexes may occur. 

• Duplicate indexes are data records, which contain the same identification number. Assuming 

the primary key is formed from the family and first name, if you have several customers 

called "John Miller" in your database, Synkronizer will not know which data records are to 

be compared. Make sure that you always operate with unique primary keys.

Once you have followed all steps as noted above, Synkronizer will recognize all differences be-

tween the two files and list them accordingly.

Access and ODBC-

Databases

Worksheet properties

normal worksheets

Databases

primary key

duplicate indexes
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Checkbox "Sort data:"

If this checkbox is selected, the data are sorted according to the primary key. Otherwise no sor-

ting is done.

2.1.3 Action

Here you can select the Action to be taken by Synkronizer. You can also determine whether the 

comparison should be made based on (1) values, (2) formulas or (3) comments.

Comparison Type

Synkronizer compares the data using the following criteria:

• "normal" values
• "case sensitive" values
• "normal" formulas
• "case sensitive" formulas
• comments

Difference between "normal" and "case sensitive" comparisons

You can compare either "normal" or "case sensitive" cell entries. If you make a "normal" com-

parison, Synkronizer ignores differences between small and capital letters (e.g. "John Miller", 

"JOHN MILLER"), however with a "case sensitive" comparison all differences are recognized.

Difference between values and formulas

The two examples below illustrate the differences between values and formulas.

The January turnover increases from $10.00 to $10.50. Accordingly, the first quarter turnover 

changes from $30.00 to $30.50. Based on a value comparison the difference between the quar-

terly amounts is highlighted as monetary differences.

The formula comparison on the other hand only recognizes the January difference, as the for-

mula for the first quarter is identical.

Comparison type

Comparison

by values

Comparison

by formulas
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With a comparison by comments, all comments are compared. Values or formulas are ignored.

Synkronizer performs the following functions:

• Highlighter
• Reporter
• Navigator Toolbar
• All of the above…

In chapter 3 of the user manual the actions are described in detail.

Comparison

by comments
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2.2 Register "Action Settings"

In this register you can determine how Synkronizer is to display the data.

2.2.1 Remove original background colors?

Here you can select whether Synkronizer removes the background color of the cells before high-

lighting the differences.

2.2.2 Highlight differences?

If you select "yes" the differences in the underlying worksheets are highlighted.

2.2.3 Which data should be displayed?

With this function you determine whether Synkronizer displays, hides or deletes data. For each 

file you can determine individually which data to be shown (1st file = Master, 2nd File = Up-

date). If the checkboxes are marked, the desired data are shown, otherwise they are hidden or 

deleted.

The following options can be selected:

Unmatched columns
If these checkboxes are selected, deleted or added columns are shown. If not, columns will be 

hidden or deleted.

Form

Display differences

Differences

to be highlighted

Rows to be hidden
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Unmatched rows
If you select these checkboxes, deleted or added rows are displayd.

Duplicate indexes
A database comparison can result in the creation of duplicate indexess. If you desire to see these 

duplicate indexes, mark these checkboxes.

Different cells
If you select these checkboxes, all rows with different cell entries are displayed.

Identical cells
All rows with no differences are shown, if you select this checkbox.

DELETE identical data instead of HIDING it?
Here you can determine whether non-marked data are to be hidden or deleted. The deletion of 
the desired data is only possible with the "Highlighter".

Show columns / rows

If the columns and/or rows are hidden and to be shown, please proceed as follows:

1. Select the entire worksheet (Keyboard Shortcut Ctrl-A)

2. Execute the following menu instruction: Format → Rows → Unhide

Show rows
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2.3 Register "Color / Language"

In this form you can select the language and color settings.

2.3.1 Color Settings

In this section you can determine the colors, with which Synkronizer highlights the differences. 

To change a color, just click with the mouse on the appropriate color surfaces (left) and select 

then the desired color (right).

2.3.2 Language Settings

Here you can change the language settings. The language data are stored in the same folder in 

which Synkronizer is installed (normally C:\Program Files\Synkronizer XL 8.0\). The language 

files have the extension "slf". At the moment, Synkronizer is available in the following languages:

• English

• German

• Spanish

• French

• Italian

• Dutch

• Swedish

• Polish
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The languages are being constantly extended. New languages can be downloaded at 

http://www.synkronizer.com/

Free registration for translators!

We will give you a free Synkronizer registration (Developer Version) if you help us translate 

Synkronizer material into your native language.

Just send us a mail at support@synkronizer.com for your free copy. Before starting your transla-

tion, please contact us for detailed instructions.
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3 Action

3.1 Highlighter

If you choose this action, Synkronizer just highlights the differences in the underlying work-

sheets:

Differences are highlighted with the following colors:

• orange for different cell entries

• light blue for deleted columns and rows 

• green for added and columns and rows

• lavender for duplicate indexes

At one glance Synkronizer clearly displays all differences and you can decide with which version 

of the worksheet you wish to proceed.

The colors listed above are the default values, you can specify your own color settings as de-

scribed in section 2.3 Register " Color / Language".

Versions:
The action "Highlight Differences" can be used with all versions of Synkronizer.

Highlight Differences

Versions
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3.2 Create a Difference Report

If desired, you can display the result of the comparison in a reader friendly difference report. On 

this report you not only see the rows or columns deleted and/or added, but also each individual 

cell with different values. The difference report displays the values entered in worksheet 1 and 

worksheet 2. This report is a great help in tracing differences and updating your Excel files.

Versions:
The action "Create a Difference Report" can be used with the following versions of Synkronizer:

• Standard Version

• Premium Version

• Developer Version

Create a

Difference Report

Versions
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3.3 Navigator Toolbar

The third function of Synkronizer is the "Navigator" toolbar: After the comparison process the 

worksheets are displayed vertically or horizontally and a user friendly tool bar is displayed, with 

which you can easily navigate through the differences.

Detailed information is described in chapter 4 Navigator.

Versions:
The "Navigator" can be used with the following versions of Synkronizer:

• Premium Version

• Developer Version

3.4 All of the above…

This option highlights the differences, creates an Excel report and then automatically starts the 

Navigator toolbar.

Navigator Toolbar

Versions
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4 Navigator Toolbar

Certainly the most comfortable function of Synkronizer is the "Navigator" toolbar. After the 

comparison process the worksheets are displayed vertically or horizontally and a user friendly 

tool bar is displayed, with which you can easily navigate through the differences. Synkronizer 

ensures that both tables are displayed on your screen in order for you to directly compare all 

differences. At this point you can decide with which version you wish to continue. With mouse-

clicks you can transfer values from table 1 to table 2 or vice versa. This is the quickest way to 

eliminate all differences and within a short period of time you will have your Excel worksheet 

perfectly updated.

After the comparison process the worksheets are tiled vertically and a user friendly tool bar ap-

pears:

4.1 Tool Bar

The Navigator tool bar is as follows:

The Navigator tool bar contains the following functions:

1 - 2) Tile worksheets
By using these buttons you can tile the worksheets vertically (1) or horizontally (2).

Navigator

worksheets view

Navigator

tool bar

Description

symbols
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3) Zoom
With this command you can zoom the worksheets.

4 - 8) Navigation command
With these commands you can navigate through each difference (commands 4, 5, 7, 8) or 

jump directly to a particular difference (6).

9) Total differences
This describes the total number of differences found between the two files.

10) Update "Update"
With this command the differences are transferred from the "Master"-file (left) to the 

"Update" file (right). This overwrites the change with the original data.

Note:
only the highlighted difference is updated.

11) Update "Master"
With this command the differences are transferred from the "Update"-file (right) to the 

"Master" file (left). This overwrites the original data with the updated data. 

Note:
only the highlighted difference is updated.

12) Show / Update
If you click on this switching surface a menu appears with which you can show/hide the 

data and update them. 

13) Remove background color
By using this command the background color of the differences will be deleted. All other 

background colors remain unchanged.

14) Close tool bar
With this command the tool bar will be closed.
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4.2 Show / Update

With this menu you can show or hide differences. The show menu contains the following: func-

tions:

4.2.1 Show / hide differences

With the menu commands 1 to 5 you can show or hide the desired differences dynamically. De-

pending on whether the menu commands have a checkmark on the left, differences are shown 

or hidden. With a checkmark differences, are shown, without one they are hidden.

The following is an explanation of the different menu commands:

1) Unmatched columns
If this menu option is selected, deleted (only in "Master" file) and added (only in "Update" 

file) colums are shown.

2) Unmatched rows
With this option, deleted and/or added rows are shown.

3) Duplicate indexes
With a database comparison duplicates can occur. According to whether this menu option is 

marked or not, duplicates are visible (or not).

4) Different values
With this selection, rows with different cell values (or formulas or comments) are shown.

5) Unchanged rows
Unchanged rows contain the same data in both files. These rows can be shown or not if you 

select this menu.

Show / Update

Show / hide

differences
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4.2.2 Update Master 

In this menu (6) you can update the "Master" file (table left hand side) by using the following 

functions:

8) Added columns
the added columns (of the file "Update") can be added to the "Master"-file. The columns 

will be transferred from the right to the left worksheet.

9) Added rows
the added rows (of the file "Update") can be added to the "Master"-file. The rows will be 

transferred from the right to the left worksheet.

10) Different values
the cells, which contain different values, can be transferred to the "Master"-file. The differ-

ences can be transferred directly or by manual confirmation.

11) Formats
the cell formats can be transferred from the "Update"-file to the "Master"-file.

the following formats will be transferred:

- number

- alignment

- font

- border

- patterns

- protection

these formats remain unchanged:

- merged cells

4.2.3 Update "Update"

Within this menu (7) you can update the "Update"-file. The menu functions are identical with 

the menu "Update Master" with the difference that the data are transferred from the "Master"-

file to the "Update"-file (or from left to right).

Update Master

Update "Update"
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5 Synkronizer with Visual Basic for Applications

Synkronizer can also be controlled using Visual Basic for Applications (VBA). This has the ad-

vantage that recurring, standardized or complex comparison processes can be automated.

Versions:
Synkronizer VBA can be used with the following version of Synkronizer:

• Developer Version

5.1 Syntax

The syntax of the Synkronizer functions is as follows:

Synkronizer(sFileOld As String, _

            sFileNew As String, _

            sSheetOld As Variant, _

            sSheetNew As Variant, _

            Optional sRangeOld As String, _

            Optional sRangeNew As String, _

            Optional sKeyFields As String, _

    Optional iCompareType As Integer, _

            Optional iActionFlags As Integer, _

            Optional sReportFile As String) As Variant

5.2 Return Value

The return value of the Synkronizer function is presented as follows : 

False Synkronizer could not interpret one or more of the arguments or errors 

during processing.

"" Synkronizer found no differences and returns an empty string.

Character sequence Synkronizer detected differences and returns the differences in a charac-

ter sequence, whereby the individual differences are separated by commas 

and semicolons.

Example:
Synkronizer returns the following character sequence:

new rows,5;different cell values,14

This means that Synkronizer could detect 5 new lines and 14 different 

cell values.

Versions

Syntax

Return Value
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5.3 Arguments

The function contains the following arguments.

sFileOld File (incl. Path) of the 1
st

 file (Master).

You can use Excel-, text- and odc-files. Access databases must be entered 

in an odc file.

sFileNew File (incl. Path) of the 2
nd

 file (Update).

sSheetOld Worksheet name or number of the 1
st

 file. You can enter the following 

values:

1 the first worksheet of the 1
st

 file will be compared

3 the third worksheet of the 1
st

 file will be compared

"sheet1" the worksheet with the caption "sheet1" will be compared

"" all worksheets will be compared.

sSheetNew Worksheet name or number of the 2
nd

 file.

sRangeOld Optional. A1-Range of 1
st

 worksheet. If this argument is empty, all cells 

will be compared.

aRangeNew Optional. A1-Range of 2
nd

 worksheet.

sKeyFields Optional. If you want to make a database-comparison, please enter the 

names of the keys in this section. The keys are divided with semicolons 

";" (e.g. Family name; Fist name; City). If you do not make a database-

comparison, leave the field empty.

iCompareType Optional. This argument contains the comparison function. You can 

enter the following arguments:

1 comparison by "normal" values

2 comparison by "case sensitive" values

3 comparison by "normal" formulas

4 comparison by "case sensitive" formulas

5 comparison by comments

If the argument is empty, a comparison by "normal" values is executed 

(see also 2.1.3 Action).

iActionFlags Optional. This argument contains the action function. You can enter the 

following arguments:

1 the differences are highlighted

2 a difference report is created

4 Navigator toolbar

The values can be combined. E.g. if a 3 is entered, then the differences 

are highlighted and a difference report is provided. If the field is empty, 

the differences are highlighted.

Arguments
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sReportFile Optional. If you want to create a difference report, just enter the filename 

(incl. Path) for the report to be created (e.g. C:\Documents\Report.xls).
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5.4 Using  Synkronizer in your VBA Scripts

To execute Synkronizer with VBA, set a reference to Synkronizer in your scripts. To set a refer-

ence, proceed as follows:

1. open the Excel worksheet that contains the VBA script

2. open the VBA Editor (Keyboard Shortcut Alt-F11)

3. set the focus to your VBA script

4. go to the Tools menu and select References

5. find 'SynkronizerXL' in the list, and put a check next to it

Now you are able to use the Synkronizer-function. You can see some examples of VBA scripts 

below. Please feel free to use them.

5.5 VBA-Examples

5.5.1 Example 1

This example highlights the differences between the worksheets named "Addresses" in  the files 

FileOld and FileNew.

Public Sub Example_1()

    Dim varSynk As Variant

    On Error GoTo Err_Message

    varSynk = Synkronizer(sFileOld:="C:\Documents\FileOld.xls", _

                          sFileNew:="C:\Documents\FileNew.xls", _

                          sSheetOld:="Addresses", _

                          sSheetNew:="Addresses")

    Select Case varSynk

        Case False

            MsgBox "Error", _

                   vbOKOnly + vbExclamation

        Case ""

            MsgBox "No differences noted", _

                    vbOKOnly + vbInformation

        Case Else

            MsgBox "Synkronizer found differences:" & _

                   Chr(10) & Chr(10) & varSynk, _

                   vbOKOnly + vbInformation

    End Select

Exit Sub

Err_Message:

    MsgBox Err.Description, vbOKOnly + vbExclamation

End Sub

VBA Examples
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5.5.2 Example 2

This example highlights the differences in all worksheets of the two files.

Public Sub Example_2()

  Dim varSynk As Variant

    On Error GoTo Err_Message

    varSynk = Synkronizer(sFileOld:="C:\Documents\FileOld.xls", _

                          sFileNew:="C:\Documents\FileNew.xls", _

                          sSheetOld:="", _

          sSheetNew:="")

    Select Case varSynk

        Case False

            MsgBox "Error", _

                   vbOKOnly + vbExclamation

        Case ""

            MsgBox "No differences noted", _

                    vbOKOnly + vbInformation

     Case Else

            MsgBox "Synkronizer found differences:" & _

                   Chr(10) & Chr(10) & varSynk, _

                   vbOKOnly + vbInformation

    End Select

Exit Sub

Err_Message:

    MsgBox Err.Description, vbOKOnly + vbExclamation

End Sub
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5.5.3 Example 3

This procedure compares the first worksheet of both Excel files and creates a difference re-
port called "Report.xls".

Public Sub Example_3()

    Dim varSynk As Variant

    On Error GoTo Err_Message

    varSynk = Synkronizer(sFileOld:="C:\Documents\FileOld.xls", _

                          sFileNew:="C:\Documents\FileNew.xls", _

                          sSheetOld:=1, _

                          sSheetNew:=1, _

                          iActionFlags:=2, _

                      sReportFile:="C:\Documents\Report.xls")

    Select Case varSynk

        Case False

            MsgBox "Error", _

                   vbOKOnly + vbExclamation

        Case ""

            MsgBox "No differences noted", _

         vbOKOnly + vbInformation

        Case Else

            MsgBox "Synkronizer found differences:" & _

                   Chr(10) & Chr(10) & varSynk, _

                   vbOKOnly + vbInformation

    End Select

Exit Sub

Err_Message:

  MsgBox Err.Description, vbOKOnly + vbExclamation

End Sub
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5.5.4 Example 4

This example compares the formulas of the databases "Addresses". The primary key is "ID". 

The differences are highlighted in both files.

Public Sub Example_4()

    Dim varSynk As Variant

    On Error GoTo Err_Message

    varSynk = Synkronizer(sFileOld:="C:\Documents\FileOld.xls", _

                          sFileNew:="C:\Documents\FileNew.xls", _

                          sSheetOld:="Addresses", _

  SSheetNew:="Addresses", _

                          sKeyFields:="ID", _

                          iCompareType:=3)

    Select Case varSynk

        Case False

            MsgBox "Error", _

                   vbOKOnly + vbExclamation

        Case ""

           MsgBox "No differences noted", _

                    vbOKOnly + vbInformation

        Case Else

            MsgBox "Synkronizer found differences:" & _

                   Chr(10) & Chr(10) & varSynk, _

                   vbOKOnly + vbInformation

    End Select

Exit Sub

Err_Message:

    MsgBox Err.Description, vbOKOnly + vbExclamation

End Sub
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5.5.5 Example 5

This procedure compares the comments of the databases "Addresses". The keys are "Family-

name" and "Firstname". The differences are highlighted in both files.

Public Sub Example_5()

    Dim varSynk As Variant

    On Error GoTo Err_Message

    varSynk = Synkronizer(sFileOld:="C:\Documents\FileOld.xls", _

                          sFileNew:="C:\Documents\FileNew.xls", _

                         sSheetOld:="Addresses", _

                          sSheetNew:="Addresses", _

                          sKeyFields:="Familyname;Firstname", _

                          iCompareType:=5)

    Select Case varSynk

        Case False

            MsgBox "Error", _

                   vbOKOnly + vbExclamation

        Case ""

            MsgBox "No differences noted", _

                    vbOKOnly + vbInformation

        Case Else

            MsgBox "Synkronizer found differences:" & _

                   Chr(10) & Chr(10) & varSynk, _

                   vbOKOnly + vbInformation

    End Select

Exit Sub

Err_Message:

    MsgBox Err.Description, vbOKOnly + vbExclamation

End Sub
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5.5.6 Example 6 (Compare Multiple Files)

This procedure compares one Master-file (Master.xls) with all files within the folder 

"C:\Documents\New\" and produces a difference report for every comparison. The difference 

reports are saved in the folder "C:\Documents\Reports\".

Public Sub Example_6()

    Dim varSynk As Variant

    Dim strFileOld, strFileNew As String

    Dim strFolderNew As String

    Dim strFolderReport As String

    Dim strFileReport As String

    On Error GoTo Err_Message

    Set a = Application

    strFileOld = "C:\Documents\Old\Master.xls"

    strFolderNew = "C:\Documents\New\"

    strFolderReport = "C:\Documents\Reports\"

    strFileNew = Dir(strFolderNew & "*.xls")

    Do While strFileNew <> ""

        strFileReport = "Difference Report " & strFileNew

        varSynk = Synkronizer(sFileOld:=strFileOld, _

                              sFileNew:=strFolderNew & strFileNew, _

                              sSheetOld:=1, _

                              sSheetNew:=1, _

       iActionFlags:=2, _

                              sReportFile:=strFolderReport & strFileReport)

        If varSynk = False Then End

        Workbooks(strFileNew).Close SaveChanges:=True

        Workbooks(strFileReport).Close

        strFileNew = Dir

    Loop

Exit Sub

Err_Message:

    MsgBox Err.Description, vbOKOnly + vbExclamation

End Sub

Compare multiple files


